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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider TDS and Avaya IP Office Release 10.0.

TDS SIP Trunk Service (TDS) provides PSTN access via a SIP trunk between the enterprise
and the TDS network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

TDS is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between TDS and the Avaya IP Office solution. In the sample configuration, the Avaya IP
Office solution consists Avaya IP Office 500 V2 Release 10.0, Avaya embedded Voicemail, Avaya
IP Office Application Server (with WebRTC and one-X Portal services enabled), Avaya
Communicator for Windows (SIP mode), Avaya Communicator for Web, Avaya H.323, Avaya SIP,
digital and analog endpoints. The enterprise solution connects to the TDS network.

The TDS referenced within these Application Notes is designed for business customers. The service
enables local and long distance PSTN calling via standards-based SIP trunks as an alternative to
legacy analog or digital trunks, without the need for additional TDM enterprise gateways and the
associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to TDS.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the TDS network
should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is the
responsibility of each individual vendor. Readers should consult the appropriate vendor-supplied
product documentation for more information regarding those products.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to TDS. To verify SIP trunking
interoperability, the following features and functionality were exercised during the interoperability
compliance test:
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Incoming PSTN calls to various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to
the enterprise across the SIP trunk from the service provider

Outgoing PSTN calls from various phone types. Phone types included Avaya H.323, Avaya
SIP, digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider

Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode)

Inbound and outbound PSTN calls from/to the Avaya Communicator for Web with basic
telephony transfer feature

Inbound and outbound long hold time call stability

Various call types including: local; long distance; international call; outbound toll-free;
outbound to assisted operator, 411 and 911 services during the compliance testing

SIP transport using UDP as supported

Codec G.711MU

Caller number/ID presentation

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls

DTMF transmission using RFC 2833

Voicemail navigation for inbound and outbound calls

Telephony features such as hold and resume, transfer, and conference

Fax G.711 pass-through mode

Use Diversion header in off-net call forwarding

Use SIP re-Invite or SIP Refer in off-net call transfer

Twinning to mobile phones on inbound calls

Item not supported by TDS Lab Environment include the following:

Inbound toll free call
Fax T.38
TLS/SRTP

2.2. Test Results

Interoperability testing of TDS was completed with successful results for all test cases with the
exception of the limitation described below:

Blind Call Transfer using Avaya 1140E SIP phone did not complete until transferee
picked up the call - The expected behavior of the SIP phone was that after transferring, the
phone should display “Transfer successful”. In this case, the user pressed “Trnsft” button,
answered “No” to the question of “Consult with party?”” which implied the blind transfer, the
transferee phone was ringing and the SIP phone should be released and displaying “Transfer
successful”. Instead, the SIP phone was still displaying “Transferring” and did not released
until the transferee phone answered the call. This is very minor known limitation on Avaya
1140E SIP phone. There was no user impact. Transfer was still completed with 2-way audio.

2.3. Support
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For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on TDS SIP Trunking, contact TDS at https://tdsbusiness.com/products/voip-
phone/trunking.html
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to TDS through the public IP network. For confidentiality and privacy purposes, actual
public IP addresses used in this testing have been masked out and replaced with fictitious IP
addresses throughout the document.

The Avaya components used to create the simulated customer site included:
Avaya IP Office 500 V2

Avaya embedded Voicemail for IP Office

Avaya Application Server (Enabled WebRTC and one-X Portal services)
Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phone

Avaya Analog phone

Avaya Communicator for Windows (SIP)

Avaya Communicator for Web

Located at the enterprise site is an Avaya IP Office 500 V2 with the MOD DGTL STAL16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network.
Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1100 Series IP
Telephone (with SIP firmware), Avaya 1408D Digital Telephone, Avaya Analog Telephone, and
Avaya Communicator for Windows.

A separate Windows 10 Enterprise PC runs Avaya IP Office Manager to configure and administer
the Avaya IP Office system.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at configured mobile phones.
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Figure 1 - Test Configuration for Avaya IP Office with TDS SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to TDS. The short code of 9 was stripped off by Avaya IP Office but
the remaining N digits were sent unaltered to TDS. For calls within the North American Numbering
Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP calls, Avaya IP Office
would send 11 digits in the Request URI and the To field of an outbound SIP INVITE message. It
was configured to send 10 digits in the From field. For inbound calls, TDS sent 10 digits in the
Request URI and the To field of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 6 of 35
SPOC 5/19/2017 ©2017 Avaya Inc. All Rights Reserved. TDS-IPO10



scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office solution

Avaya IP Office 500V2

Embedded Voicemail

Avaya Web RTC Gateway

Avaya one-X Portal

Avaya IP Office Manager

Avaya IP Office Analogue PHONE 8
Avaya IP Office VCM64/PRID U
Avaya IP Office DIG DCPx16 V2

10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 10
10.0.0.3.0 build 9
10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 5
10.0.0.3.0 build 5

Avaya 1140E IP Deskphone (SIP) 04.04.23
Avaya 9641G IP Deskphone 6.6.3.02_ V474
Avaya 9621G IP Deskphone 6.6.3.02_ V474
Avaya Communicator for Windows (SIP) 2.1.3.237
Avaya Communicator for Web 1.0.16.1718
Avaya 1408D Digital Deskphone R46

Avaya Analog Deskphone N/A

HP Officejet 4500 (fax) N/A

TDS Components

Equipment

Release

Perimeta Metaswitch SBC

3.9.40Su27

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.

HV; Reviewed:
SPOC 5/19/2017

Solution & Interoperability Test Lab Application Notes 8 of 35
©2017 Avaya Inc. All Rights Reserved.

TDS-IPO10



5. Configure Avaya IP Office Solution

This section describes the Avaya IP Office solution configuration necessary to support connectivity
to TDS. It is assumed that the initial installation and provisioning of the Avaya IP Office 500 V2 has
been previously completed and therefore is not covered in these Application Notes. For information
on these installation tasks refer to Additional References Section 9.

This section describes the Avaya IP Office configuration to support connectivity to the TDS system.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC
running the Avaya IP Office Manager application, select Start - Programs - IP Office >
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window and click OK button. Log in using appropriate
credentials.

"
File Edit View Tools Help

R BOOTP (5)
¢ Operator (3)

B Select IP Office = m] X

Name IP Address  Type Version Edition
Release 10.0
l IPOffice_1 10.10.98.14  IP500V2 10.0.0.3.0build 5 IP Office

TCP Discovery Progress

Unit/Broadcast Address

10.1098.14 < Refresh Cancel

Figure 2 — Avaya IP Office Selection
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5.1. Licensing

The configuration and features described in these Application Notes require the Avaya IP Office
system to be licensed appropriately. If a desired feature is not enabled or there is insufficient
capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels license with sufficient capacity, select IPOffice_1 »>
License on the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a
valid license with sufficient “Instances” (trunk channels) in the Details pane.

IP Offices | License
R BOOTP (5) License Type ~ Status License Remote Server
4 Operator (3)
=-*39|IPOffice_1 License Mode License Normal
9 System (1) . .
1 Line (4) Licensed Version 10.0

=2 Control Unit (4) PLDS Host ID 111316612166

4 Extension (40)

§ User34) PLDS File Status ~ Valid
% Group (1) )
g ghor.t Co(;ie (60) Feature Instances Status Expiration Date Source )
& ReAr;I(CG( ; Receptionist 4 Valid Never PLDS Nodal
e Incoming Call Route (14) Additional Voicemail Pro Ports 152 Valid Never PLDS Nodal
€2 WAN Port (0) VMPro Recordings Administrators 1 Valid Never PLDS Nodal
= ?ii::t;zfgloe] - Essential Edition Additional Voice... 4 Valid Never PLDS Nodal
‘@ Firewall Profile (1) VMPro TTS (Generic) 40 Valid Never PLDS Nodal
IP Route (2) Teleworker 384 Valid Never PLDS Nodal
#m Account Code (0) Mobile Worker 384 Valid Never PLDS Nodal
L I License (31) Office Worker 384 Valid Never PLDS Nodal
w T“""e_l © Avaya Softphone Licence 100 Valid Never PLDS Nodal
& k) " VMPro TTS (Scansoft) 2 Valid Never PLDS Nodal
“¢ ARS (1) VMPro TTS Professional 40 Valid Never PLDS Nodal
&5 Location (0) IPSec Tunnelling 1 Valid Never PLDS Nodal
ﬁ Authorization Code (0) Power User 384 Valid Never PLDS Nodal
Avaya IP endpoints 384 Valid Never PLDS Nodal
IP500 Voice Networking Channels 32 Valid Never PLDS Nodal
SIP Trunk Channels 128 Valid Never PLDS Nodal
IP500 Universal PRI (Additional cha... 100 Valid Never PLDS Nodal
CTl Link Pro 1 Valid Never PLDS Nodal
Wave User 16 Valid Never PLDS Nodal
3rd Party IP Endpoints 384 Valid Never PLDS Nodal
Essential Edition 1 Valid Never PLDS Nodal <

Figure 3 — Avaya IP Office License
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5.2. System Tab

Navigate to System (1) under the IPOffice_1 on the left pane and select the System tab in the
Details pane. The Name field can be used to enter a descriptive name for the system. In the reference
configuration, IPOffice_1 was used as the name in IP Office.

IP Offices \ System IPOffice_1 o v

& BOOTP (5) Hame LANT LAN2 DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM  VolP  VolP Security Contact < |*

¢+ Operator (3) =% IPOffice_1 A
- [IPOffice_1 ‘Name IPOffice_1 | Locale United States (US English) v
i System (1)

T4 Line (4) Location <None> v
= Control Unit (4)

4 Extension (40)

§ User3y Set contact information to place System under special control

2% Group (1)

9% Short Code (60)

@ Service (0)

ok RAS (1)

Contact Information

@ Incoming Call Route (14)
€9 WAN Port (0)

£ Time Profile (0)
@ Firewall Profile (1) TFTP Server IP Address 255 255 255 255

K@ 1P Route (2)

am Account Code (0) HTTP Server IP Address 0 0 0 0
,:; #::::((03)1) Phone File Server Type Memory Car v HTTP Redirection | Off <
&3 User Rights (9) Manager PC IP Address 255 . 255 . 255 . 255
8 Auto Attendant (0)
‘€ ARS (1) Avaya HTTP Clients Only =
; ;cuct:t;::a(t?)on T Enable Softphone HTTP Provisioning [ Favor RIP Routes, over static routes
Automatic Backup
Time Setting Configuration Source Voicemail Pro/Manager v
Time Settings
Time Server Address 0 0 0 0

Time Offset (hh:mm) 00:00 |

File Writer IP Address 10 10 98 79 v
< >

Figure 4 - Avaya IP Office System Configuration
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5.3. LAN2 Settings
In the sample configuration, LANZ is used to connect the enterprise network to the TDS network.

To configure the LAN2 settings on the IP Office, complete the following steps. Navigate to
IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the LAN2 -
LAN Settings tab in the Details Pane. Set the IP Address field to the IP address assigned to the
Avaya IP Office LAN2 port. Set the IP Mask field to the mask used on the public network. All other
parameters should be set according to customer requirements. Click OK to submit the change.

IP Offices \ System i IPOffice_1" o il
x g‘;g:fof(’s) fare System  LAN1 DNS  Voicemail Telephony Directory Services System Events SMTP SMDR VCM  VolP  VolP Security Contaci « | *
»L mlECHesst VolP  Network Topology
% System (1)
= L.::(:; 1P Address 0 .10 . 98 . 14
% Control Unit (4) -
& Extension (40) 1P Mask 255 . 255 . 255 . 192
?H gf:;f?i) Primary Trans. IP Address 0 0 0 0
:é‘ s C‘(’;]e (60) Firewall Profile <None> v
ervice
ok RAS (1) RIP Mode None v
 Incoming Call Route (14)
€2 WAN Port (0) [ Enable NAT
= Directory (0)
£7) Time Profile 0) Number Of DHCP IP Addresses |1
@ Firewall Profile (1) DHCP Mode
Kl P Route (2)
am Account Code (0) O Server O Client O Dialin @ Disabled Advanced
% License (31)
@& Tunnel (0)
§4 UserRights (9)
8 Auto Attendant (0) Cancel Help
Figure 5 - Avaya IP Office LAN2 Settings
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The VolIP tab as shown in the screenshot on the next page was configured with following settings:
e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to TDS

system

o Verify Keepalives to select Scope as RTP-RTCP with Periodic timeout 60 and select

Initial keepalives as Enabled

e All other parameters should be set according to customer requirements

e Click OK to submit the changes

=Y IPOffice_1*

& - v

System LAN1 DNS
LAN Settings

H.323 Gatekeeper Enable
[[] Auto-create Extension

Network Topology

Auto-create User

Voicemail Telephony Directory Services System Events

SMTP

SMDR VCM  VoIP VolIP Security Contact Center

[] H.323 Remote Extension Enable

H.323 Signaling over TLS Disabled v ‘ 1720 2
SIP Trunks Enable
SIP Registrar Enable
[[] Auto-create Extension/User [] SIP Remote Extension Enable
SIP Domain Name ‘10'10'98'14 ’
SIP Registrar FQDN \ |
upP UDP Port 5060 $ 060 <
Layer 4 Protocol TCP TCP Port 5060 < =
TLS TLSPort 5061 % 61 =
Challenge Expiration Time (sec) 10 o
RTP
Port Number Range
Minimum 46750 = Maximum 50750
Port Number Range (NAT)
Minimum 46750 = Maximum 50750
[] Enable RTCP Menitoring on Port 5005
RTCP collector IP address for phones | O 0
Keepalives
Scope RTP-RTCP v!| Periodic timeout
Initial keepalives Enabled v

DiffServ Settings

B8 +4 DSCP(Hex) (B8 < Video DSCP (Hex) |FC

46 = nsce 46 21 Viden DSCP 63

DSCP Mask (Hex) |88

-
v

SIG DSCP (Hex)

=1 DSCP Mask 34 =4 SIG DSCP Y
OK Cancel Help
Figure 6 - Avaya IP Office LAN2 VolP
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On the Network Topology tab in the Details Pane, configure the following parameters:

Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN Server will not be used

Set the Binding Refresh Time (sec) to 60. This value is used as one input to determine the
frequency at which Avaya IP Office will send SIP OPTION messages to service provider to
keep the connection alive

Set Public IP Address to the IP address of the Avaya IP Office LAN2 port

Set Public Port for UDP as 5060 (For SIP Trunk connecting to TDS)

All other parameters should be set according to customer requirements

Click OK to submit the changes

7

IPOffice_1* o v

System LAN1 DNS Voicemail Telephony Directory Services System Events SMTP  SMDR VCM  VoIP VolP Security Contact Center

LAN Settings VolP | Network Topology

Network Topology Discovery

ubp

STUN Server Address @.0.0 STUN Port 3478 *

Firewall/NAT Type Open Internet v

Binding Refresh Time (sec) 60 =

Public IP Address 10 10 %8 14 Run STUN Cancel
Public Port

5060

TCP

TLS

5060

4 4 4

5061

[J Run STUN on startup

0K Cancel Help

Figure 7 - Avaya IP Office LAN2 Network Topology
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5.4. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes (not shown) and then
navigate to the Telephony - Telephony tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (sec) to a valid number. Set Default Name
Priority to Favor Trunk. Defaults were used for all other settings. Click OK to submit the changes.

=Y IPOffice_1* f v

System LAN1 LAN2 DNS Voicemail | Telephony | Directory Services System Events SMTP  SMDR VCM  VoIP VolP Security Contact Center
Telephony| Park & Page Tones & Music Ring Tones SM CallLog TUI

Analogue Extensions Companding Law 2
Switch Line
Default Outside Call Sequence Normal ~
Default Inside Call Sequence Ring Type 1 a5 © U-LawLine
Default Ring Back Sequence Ring Type 2 v
A-la A-Law Line
Restrict Analogue Extension Ringer Voltage E © & o e
Dial Delay Time (sec) 4 = |1 DSSStatus
Dial Delay Count 0 : D Ao
. = Dial By Name
Default No Answer Time (sec) 15 b g
Show Account Code
Hold Timeout (sec) 3600 S M
= [ Inhibit Off-Switch Forward/Transfer
Park Timeout (sec) 300 =
= [] Restrict Network Interconnect
Ring Delay (sec) 5 S

- Include location specific information
Call Priority Promotion Time (sec) |Disabled

Drop External Only Impromptu Conference

Default Currency usb v
O Visually Differentiate External Call
Default Name Priority Favor Trunk s
[J Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation Enabled v g - <
High Quality Conferencing
Phone Failback Automatic v

Digital/Analogue Auto Create User
Login Code Complexity

e ’ Directory Overrides Barring

nforcement
Minimum length |4 Py [] Advertise Callee State To Internal Callers
Complexity

RTCP Collector Configuration
[C] Send RTCP to an RTCP Collector

Figure 8 - Avaya IP Office Telephony
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5.5. System VolIP Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
VolIP tab in the Details Pane. Leave the RFC2833 Default Payload as default of 101. Select codec
G.711 ULAW 64K which TDS supports. Click OK to submit the changes.

IP Offices | System i= IPOffice_1 & e

,x BOOTP (5) Name System LAN1 LAN2 DNS  Voicemail Telephony Directory Services SystemEvents SMTP SMDR VCM VoIP Security Contaci ¢ | »

¢+ Operator (3 =9 |POffice_1
“(IPOffice_1 - Ignore DTMF Mismatch For Phones
[ System (1) O

£7 Line @) Allow Direct Media Within NAT Location

“= Control Unit (4)

& Extension (40) RFC2833 Default Payload 0 & l
ﬂ User (34)

@ Group (1) Available Codecs Default Codec Selection

8% Short Code (60) Unused Selected

B Service (0) 5711 ULAW 63K [ 55> G.711 ULAW 64K

ok RAS (1) 5.711 ALAW 64K G.729(a) 8K CS-ACELP
€ Incoming Call Route (14) 0] 6.722 64K G.711 ALAW 64K

€2 WAN Port (0) G.729(a) 8K CS-ACELP G.723.1 6K3 MP-MLQ

2 Directory (0) S g
£2) Time Profile (0 6.723.1 6K3 MP-MLQ

@ Firewall Profile (1)
IP Route (2)
#m Account Code (0)

% License (31) 355
@& Tunnel (0) -
§5 UserRights (9)

8 Auto Attendant (0)

‘€ ARS (1)

&5 Location (0) Cancel Help
% Authorization Code (0)

Figure 9 - Avaya IP Office VolP
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5.6. Administer SIP Line

A SIP Line is needed to establish the SIP connection between Avaya IP Office and the TDS system.
The recommended method for configuring a SIP Line is to use the template associated with these
Application Notes. The template is an .xml file that can be used by Avaya IP Office Manager to
create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:
e |P addresses
SIP Credentials (if applicable)
SIP URI entries
Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
SIP Line — Originator number for forwarded and twinning calls
Transport — Second Explicit DNS Server

SIP Credentials — Registration Required

SIP Advanced Engineering

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New = SIP Line. Then, follow the steps outlined in Section 5.6.2. For the compliance
test, SIP Line 17 was used as trunk for both outgoing and incoming calls.
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5.6.1. Create SIP Line from Template
1. Create a new folder in the computer where Avaya IP Office Manager is installed (e.g.,
C:\TDS\Template). Copy the template file (TDS-1PO10.xml) to this folder.
2. Create the SIP Trunk from the template: Right-click on Line in the Navigation Pane, then
navigate to New from Template - Open from file.

IP Offices Line =
g R BOOTP (5) Line Number  Line Type PRI 24 Line Channels
47 Operator (3) PRI 24
=% IPOffice 7 '
.f..,;.\, ice ] New " Line Number
""" T_‘iéﬁ]i Cut Ctrl+X o
...... = Con
..... & Exte| 52 Copy Ctrl+C Port
% g:: . Paste Ctrl+V Sunich Type
7<  Delete Ctrl+Del
""" 8% Sho " _ Send Service Messages
..... @ Send o Validate
..... % RAS Cannect ok Cirl«T Channel Allocation
..... Inc
..... 157 WAR! ] New from Template » | Open from file
..... 2 Direl[ 7] Show| Add 'Not end-to-end ISDN'
..... £ Tim owInGroups Information Element
""" % IFpif;\ Customize Columns... progress Rep|acement
_____ am Acc Change Unlveis‘al PRI Card Line Type » Send Redirecting Number
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Figure 10 — Create SIP Line from Template
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3. Select the Template Files (*.xml) and select the copied template from step 1 at IP Office
template directory C:\TDS\Template\. Click Open button to create a SIP line from template.

IP Offices | Line = PRI 24 (Universal) - Line 1
~& BOOTP (5) Line Number  Line Type PRI 24 Line Channels
4/ Qperator (3) PRI 24
=+ |POffice_1 i 01 i
y e S;tegm 2 -2 PRI 24 (Universal) Line Number Line SubType PRI
17 Line (3) 1 PRI 24 (Universal) Card
0 Control Unit (4) SIP Line . | P— At e
& Extension (40)
§ User34) * Open X
G 1
a SP:z:‘tPC(o)de 60) &« v A > ThisPC > 0OS(C) » TDS > Template v D Search Template yel
Service (0)
g RAS (1) Organize v New folder S=7iw 18| 0
g l\lr\jli\ol\lml;gifg)" Route/(1d) RW A Name Date modified Type Size
2= Directory (0) TDS-IPO10-UDP + [TDS-IPOT0 4/5/20172:58PM XML Document 4KB
£ Time Profile (0) Silip S
@ Firewall Profile (1) @ OneDrive
Kl 1P Route (2)
-8 Account Code (0) 3 This PC
% License (31)
ket
@& Tunnel (0) . Deskiop
§3 UserRights (9) || Documents
: ﬁago(gttendant © & Downloads
&8 Location (0) j Music
% Authorization Code (0) =) Pictures
m Videos
B 0S(C)
s RECOVERY (E:)
=¥ Network v
File name: | TDS-IPO10 v| Template Files (*xml) v
| Open | Cancel

Figure 11 — Create SIP Line from IP Office Template Directory
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A pop-up window below will appear stating success (or failure). Then click OK to continue.

Template Provisicning X

0 New SIP Trunk created successfully using selected template,

Figure 12 — Create SIP Line from Template successfully

4. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.6.2.
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5.6.2.

Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New > SIP Line (not shown).

On the

SIP Line tab in the Details Pane, configure the parameters as shown below:

e Select available Line Number, 17 in this case
e Set ITSP Domain Name to TDS SIP signaling server IP address. This field is used to
specify the default host part of the SIP URI in the To and R-URI fields for outgoing calls
e Set Local Domain Name to IP address of Avaya IP Office LAN2 port. This field is used to
specify the default host part of the SIP URI in the From field for outgoing calls
Note: For the user making the call, the user part of the From SIP URI is determined by the
settings of the SIP URI channel record being used to route the call (see SIP URI - Local
URI). For the destination of the call, the user part of the To and R-URI fields are determined
by dial short codes of the form 9N;/N“@192.168.63.146” where N is the user part of the SIP
URI and “@192.168.63.146” can be used to override the host part of the To and R-URI
e Check the In Service and Check OOS boxes
e SetURI Typeto SIP
e For Session Timers, set Refresh Method to Re-invite with Timer (sec) to 1200
e Set Name Priority to Favor Trunk. As described in Section 5.4, the Default Name
Priority parameter may retain the default Favor Trunk setting, or can be configured to
Favor Directory. As shown below, the default Favor Trunk setting was used in the
reference configuration
e For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Auto. Note: TDS supports both re-Invite and SIP Refer in off-net transfer call
during the compliance testing
e Default values may be used for all other parameters
e Click OK to commit then press Ctrl + S to save
IP Offices | Line ] SIP Line - Line 17* gk -B x| vis
K gOOTP ) Line Number  Line Type [SIP Line] Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering
= }pe;(t:_r];) :_:I 4 PRI 24 (Universal) | | Line Number 17 [nSavice
'f;mn "2 PRI 24 (Universal) | | TSP Domain Name [192.168.63.146 || | checkoos
<= Control Unit (4) SIP Line .
'f iz{,.:gi:; 40) 7] T Local Domain Name [10109814 | —
% Group (1) URI Type SIP v
g z::rlt( S(:Od]e (60) Tocaton Cloud - Refresh Method Re-invite v
o RAS (1? Timer (sec) 1200 =
Incoming Call Route (14)
?‘7’ ey pcft(o) Prefix [ |
== Directory (0)
£ Time Profile (0) ) .
@ Firewall Profile (1) National Prefix \ ‘
) International Prefix [ |
e Tl () Country Code [ | [ Redirectand Transfer
‘53 User Rights (9) Name Priority Tt o ‘ Incoming Supervised REFER Auto v
@8 Auto Attendant (0) Outgoing Supervised REFER Auto S
¢ ARS (1) Description [ ‘ going Sup
B Location (0) Send 302 Moved Temporarily O
2% Authorization Code (0) Outgoing Blind REFER O
OK Cancel Help
Figure 13 — SIP Line Configuration
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP address of TDS Signaling Server: 192.168.63.146.
This is the SIP Proxy IP address used for outgoing SIP calls

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the IPOffice_1 - System (1) > LAN2 - Network Topology tab.
The Listen Port was set to 5060

e The Calls Route via Registrar was unchecked as TDS did not support the dynamic
Registration on the SIP Trunk

e Other parameters retain default values

e Click OK to commit then press Ctrl + S to save

IP Offices | Line 7 SIP Line - Line 17° ek - v <>

R

BOOTP (35)

¢/ Operator (3)
%2 |POffice_1

% System (1)

71 Line (3)

<2 Control Unit (4)
& Extension (40)
§ User(3a)

% Group (1)

X Short Code (60)
D Service (0)

o RAS (1)

Line Number
PRI 24

o1

2
SIP Line

- 17

Line Type

PRI 24 (Universal)
PRI 24 (Universal)|

SIP Line

SIP Line SIPURI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

’ ITSP Proxy Address [192.168.63.146 |

Network Configuration
Layer 4 Protocol UDP v Send Port 5060

Use Network Topology Info | LAN 2 v

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

@ Incoming Call Route (14) Calls Route via Registrar []
2 WAN Port (0)
@ Directory (0)
£ Time Profile (0)

@ Firewall Profile (1) Separate Registrar \

K@l P Route (2)

4| Account Code (0)
% License 3B1

S Tuooel(0)

oK Cancel Help

Figure 14 — SIP Line Transport Configuration

The SIP URI entry must be created to match any DID number assigned to an Avaya IP Office user
and Avaya IP Office will route the calls on this SIP line. Select the SIP URI tab; click the Add
button and the New Channel area will appear at the bottom of the pane (not shown). To edit an
existing entry, click an entry in the list at the top, and click Edit... button. In the example screen on
next page, the previously configured entries are edited.

A SIP URI entry was created that matched any DID number assigned to an Avaya IP Office user.
The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name to Use Internal Data. This setting allows calls on
this line whose SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.8

e Set Identity to Auto and Header to P Asserted ID

e For Forwarding And Twinning, set Send Caller ID to Diversion Header
Note: When using twinning feature, the calling party number displayed on the twinned phone
is controlled by (but not necessarily extracted from) the Send Caller ID parameter

e Set Diversion Header to None

e Set Registration to 0: <None>

e Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
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defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17)

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern

Click OK to submit the changes

Originator
Number

Send Caller ID

Forwarding And Twinning

Diversion Header

Max Sessions

50 =

Diversion Header ’None v
Registration 0: <None> ™
Incoming Group 17 v
Qutgoing Group 17 v

7 SIP Line - Line 17 o - <|>
SIP Line Transport |SIP URI| VoIP  T38 Fax SIP Credentials SIP Advanced Engineering
URI  Groups LocalURI  Centact Display Name Identity Header Originator Number Send CallerID Diversion Header Credential Add.. |*
1 17 17 <Internal> <Internal> <Internal> Auto PA| Diversion None 0: <Non...
Remove
Edit...
Edit URI oK
Local URI lUse Internal Data v}
Cancel
Contact lUse Internal Data v l
Display Name lUse Internal Data v ’
Identity
Identity ’Auto v ]
Header P Asserted ID v

Figure 15 — SIP Line SIP URI Configuration

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

The Codec Selection can be selected by choosing Custom from the pull-down menu,

HV; Reviewed:
SPOC 5/19/2017

allowing an explicit ordered list of codecs to be specified. The G.711 ULAW codec is

selected. Avaya IP Office supports the codec, which is sent to the TDS. Check the Re-invite
Supported box

Solution & Interoperability Test Lab Application Notes
©2017 Avaya Inc. All Rights Reserved.

23 0f 35
TDS-IPO10




e Set Fax Transport Support to G.711 from the pull-down menu. Note: TDS supports only
G.711 pass-through mode during the compliance testing

e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833

e Default values may be used for all other parameters

e Click OK to submit the changes

7 SIP Line - Line 17 &k - v | <

SIP Line Transpert SIP URI T38 Fax SIP Credentials SIP Advanced Engineering
[] VolP Silence Suppression

[J Local Hold Music

Codec Selection Custom = l | Re-invite Supported
Unused Selected T —
G.711 ALAW 64K . G.711 ULAW 64K
(G.729(a) 8K CS-ACELP T [] Allow Direct Media Path

QT LISNIEMO Force direct media with phones

[C] PRACK/100rel Supported

] G.711 Fax ECAN

Fax Transport Support |G.711 v
DTMF Support RFC2833 v
Media Security Disabled 5

Figure 16 — SIP Line VolIP Configuration
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5.7. Outgoing Call Routing — Short Code
The following section describes the Short Code for outgoing calls to TDS.

To create a short code, select Short Code in the left Navigation Pane, then right-click in the Group
Pane and select New (not shown). On the Short Code tab in the Details Pane, configure the
parameters for the new short code to be created. The screen below shows the details of the
previously administered “9N;” short code used in the test configuration.

e In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number

e Set Feature to Dial. This is the action that the short code will perform

e Set Telephone Number to N“@192.168.63.146”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@? is the TDS signaling server IP
address

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.6.2. This short code will use this line group when placing the outbound call

e Setthe Locale to United States (US English)

e Default values may be used for all other parameters

e Click OK to submit the changes

IP Offices \ Short Code 7 ON;: Dial* g -B X v <>
R BOOTP (5) Code || short Code
& Operator (3) Dial ;

5 % [P 1 o Code o \
% System (1) :
4 Line (3) Feature Dial v
=2 Control Unit (4) Dial Physical Extension by ID - =
& Exension (40) 'x‘f__mﬁ:ca S Telephone Number N'@192.168.63.146 ‘
§ User39) d — 7 V‘
2% Group (1) Dial Physical Extension by Nu ERINE [
g thff Cf(’:]e (60) 9%*70°N2 Locale United States (US English) v

ervice
& RAS (1) Display Message Force Account Code O
g Ez;\r;”ifg)” Route (14) | #%*DSSN Force Authorization Code []
4 o 9%°5DN
@& Directory (0) Forward Hunt Group Calls Off
£7) Time Profile (0) 5
@ Firewall Profile (1) 851
@l P Route (2) Forward Hunt Group Calls On , [
4 Account Code (0) oK Cancel Help
iy et ey < >
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following

parameters:

e For Code field, enter FNE feature code as FNEQO for dial tone

e Set Feature to FNE Service
e Set Telephone Number to 00

e SetLineGroupIDto0
e Setthe Locale to United States (US English)
e Default values may be used for other parameters
e Click OK to submit the changes
IP Offices ’ Short Code 2 FNEO00: FNE Service* e X<
R BOOTP (5) Code || short Code
% Operator (3) Dial
=)+ IPOffice_1| PXGN: Code =Y
2 System (1) 2
1% Line () PXON; Feature FNE Service
<= Control Unit (4) FNE Service |
& Extension (40) Telephone Number oo
§ User(3y) LnEG D [o
¥ Group (1) Follow Me Here neroup
g W 912N Locale United States (US English)
ervice

& RAS (1) Follow Me Here Cancel Force Account Code O
%E&?‘é"if&"“”“m 13N Force Authorization Code []
: o
2 Directory (0) Forward Hunt Group Calls Off
£ Time Profile (0) %51
@ Firewall Profile (1)
B P Route ) Forward Hunt Group Calls On 9 e Hem
#m Account Code (0) < >
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.6. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 2318. Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 2318. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by TDS. The SIP Display Name (Alias) parameter can
optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

IP Offices \ User 7 2318: 2318 gf - X v<|> @

& B0OTP (5) Name Etensioy Forwarding DialIn  Voice Recording Button Programming Menu Programming  Mobility Group Membership Announcements Personal| ¢ | »

g 3) Power User

e “'iog;:;; - FEFER 318 SIP Name [b0ssss231s |
T Line 3) 2319 2319 SIP Display Name (Alias) [H323-2318

play (Alias)

<= Control Unit (4) g-s190 8190 ‘ ‘
& Extension (40) g-s191 201 Contact 6085552318
fﬁ User G4) frs102 8192
% Group (1)
9% Short Code (60) [J Anonymous
@ Service (0)
o RAS (1)

€ Incoming Call Route (14)
2 WAN Port (0) oK Cancel Help
g Dicoctoc. ()

Figure 19 — User Configuration
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One of the H.323 IP Deskphones at the enterprise site uses the Mobile Twinning feature. The
following screen shows the Mobility tab for User 2318. The Mobility Features and Mobile
Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to
dial to reach the twinned mobile telephone, in this case 91613XXX5281. Check Mobile Call
Control to allow incoming calls from mobility extension to access FNEQO (defined in Section 5.7).

Other options can be set according to customer requirements.

=g 2318: 2318* ek-E X v|<|> @

Forwarding DialIn Voice Recording Button Programming Menu Programming Group Membership Announcements SIP Personal | ¢ | *

[ Internal Twinning

<None>

Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

Mobility Features

Mobile Twinning

Twinned Mobile Number
(including dial access code) |9161 Seest l

Twinning Time Profile <None>
Mobile Dial Delay (sec) 2
Mobile Answer Guard (sec) |0 =

[ Hunt group calls eligible for mobile twinning
[[] Forwarded calls eligible for mobile twinning
[] Twin When Logged Out

[] one-X Mobile Client

Mobile Call Control

[] Mobile Callback

Cancel Help

Figure 20 — Mobility Configuration for User
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5.9. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

o Set the Bearer Capability to Any Voice

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP

Line in Section 5.6.2
e Set the Incoming Number to the incoming DID number on which this route should match.
e Default values can be used for all other fields

IP Offices || Incoming Call Route ||i= 17 6085552318 e -8 X[ vl<|>
R BOOTP (5) Line Group ID Incoming Numbe Voice Recording  Destinations
i Operator (3) @17 6085558192
= "”1 17 6085558191

‘f‘:‘; L{;:E(?)( ) 731 6085553190 Bearer Capability Any Voice v

% Control Unit (4) @17 6085552319 Lin€ Group 1D }17 v
4 Extension (40)
§ User39) Incoming Number [possss23te |
2% Group (1)
8% Short Code (60) Incoming Sub Address \ \
g ;Zzl(cf @ Incoming CLI | ‘
e W Locale United States (US English) v
2 WAN Port (0)

@ Directory (0) Priority 1-Low v
£7) Time Profile (0)
@ Firewall Profile (1) Tag \
KA 1P Route (2)
a4 Account Code (0) Hold Music Source System Source v
. License (31) ] .
@& Tunnel (0) Ring Tone Override |None v
§3 UserRights (9)
@® Auto Attendant (0) Cancel Help
"¢ ARS (1) < >

Figure 21 — Incoming Call Route Configuration

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 6085552318 on line 17 are routed to Destination 2318 2318
as shown in the following screenshot:

IP Offices || Incoming Call Route ||i? 17 6085552318 e T TP

R BOOTP (5) Line Group ID Incoming Numbe||  sandard Voice Recording [Destinations|

7 Operator (3 7
g .'t,) 217 zg::z:z:zi TimeProfile Destination Fallback Extension

f“‘. Ely:zeaw) U] @1 B08555E190 » Default Value 23182318 v v
<2 Control Unit (4) @ 6085552319
& Extension (40) 217 6085552318
§ User(34)
% Group (1)
8% Short Code (60)
@ Service (0)
o RAS (1)
@ [Incoming CallRoute (14] =
£ WAN Port (0) oK Cancel
=g Directory (0)

Help

Figure 22 — Incoming Call Route for Destination 2318
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For Feature Name Extension Service testing purpose, the incoming calls to DID number
6085558191 were configured to access FNEOQO. The Destination was appropriately defined as
FNEOO as shown in the following screenshot:

IP Offices || Incoming Call Route |7 17 6085558191° ek - X | v <
R BOOTP (5) Line Group ID Incoming Numbe| | standard  Voice Recording
i Operator (3) Q17 6085558192
55y g TimeProfile Destination Fallback Extension
5 \POfolc(e1 = 7 5085558191
= System v
= Liyne(3) o1 005553190 » | Default Value [FnE00
{
< Control Unit (4) (-2 6085552319
& Extension (40) @17 6085552318
‘; User (34)
% Group (1)
9 Short Code (60)
@ Service (0)
RAS 1
Incoming CaIIRoute(M
!529 WAN Port (0)
= Directory (0) -
Tlme Profle () < > oK Gancel el

Figure 23 — Incoming Call Route for Destination FNE

For Voice Mail testing purpose, the incoming calls to DID number 6085558192 were configured to
access VoiceMail. The Destination was appropriately defined as VoiceMail as shown in the
following screenshot:

IP Offices Incoming Call Route || ¥ 17 6085558192" gk -8 x| v|s
& BOOTP (5) Line Group ID _Incoming Numbel | gandard  Voice Recording
”I_(;Oi;?ct::ﬁ) @ TimeProfile Destination Fallback Extension
% System (1) Wi el »  |Default Value v
T Line 3) @17 6085558190 :
= Control Unit (4) @17 6085552319
& Extension (40) @17 6085552318
f User39)
2% Group (1)
8 Short Code (60)
@ Service (0)
o RAS (1)
@([Incoming Call Route (14)]
€9 WAN Port (0)
= Directory (0) Cancel Help
) Time Profile (0) < >

Figure 24 — Incoming Call Route for Destination Voice Mail

5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. TDS SIP Trunk Configuration

TDS is responsible for the configuration of TDS SIP Trunk Service. The customer must provide the
IP address used to reach the Avaya IP Office LANZ2 port at the enterprise. TDS will provide the
customer necessary information to configure the SIP connection between Avaya IP Office and TDS.
The provided information from TDS includes:

e [P address and port number used for signaling or media servers through any security devices

e DID numbers

e TDS SIP Trunk Specification (If applicable)
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP Line of interest from the left
pane. On the Status tab in the right pane, verify the Current State for each channel (The
following screenshot shows 2 active calls at the present time).

S Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.3.0 build 5

AVAYA

Help Snapshot LogOff Exit About

IP Office System Status

] (27)
= SIP Trunk Summary
Line Service State: In Service
Lines2 Peer Domain Name: 192.168.63.146
- Resolved Address: 192.168.63.146
o Line Number: 17
] ail Number of Administered Channels: 50
] ng Number of Channels in Use: 2
Administered Compression: G711 Mu
Enable Faststart: Off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . 29
SIP Trunk Channel Licenses in Use: 2
SIP Device Features: REFER (Incoming and Outgoing)
aler IDor Ot Directi o
b a Add p Dialed Dig a D
1 1 16 Connected 00:00:03 |192.168.63.146 [G711...| RTPRelay |613XXX5281.[Extn 2318, 2318 Incoming "~
2 0 17 Connected 00:00:01 |192.168.63.146 G711...| RTPRelay Extn 8190, 8190 Outgoing
] Idle 3days01:...
4 Idie 3days01:...
5 Idle 3days 01:...
6 Idle 3days01:...
7 Ide 3days 01:...
8 Idle 3days 01:...
9 Idle 3days01:...
10 Idle 3days01:...
11 Idle 3days 01:...
12 Idle 3days01:...
13 Idle 3days01:...
14 Ide 3days01:...
15 Idle 3days 01:...
16 Idle 3days01:...
17 Idle 3days 01:...
13 Idle 3days 01:...
19 Idle 3days01:...
20 Idle 3days01:...
21 Idle 3days 01:...
22 Idle 3days01:...
23 Idle 3days01:...
24 Ide 3days01:...
25 Idle 3days 01:...
26 Idle 3days01:...
27 Idle 3days01:... 9
Trace Trace All Pause Ping Call Details Graceful Shutdown Force Out of Service Print... Save As...
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Figure 25 — SIP Trunk status

Solution & Interoperability Test Lab Application Notes
©2017 Avaya Inc. All Rights Reserved.

320f 35
TDS-IPO10



e Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start = Programs -> IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

S Avaya IP Office System Status - IPOffice_1 (10.10.98.14) - IP500 V2 10.0.0.3.0 build 5 = X

AVAyA IP Office System Status

Help Snapshot LogOff Exit About

B System
H B Alarms (8) Select a line to display the alarm information
) Module / Slot / Type Port Number / Address / Domain

& Service (3)
1 Slot: 1 1 2
= »o T : 2

T Slot: 1 2 2
ine:1(2) [ 5P 192.168.63.146 0]

& Line:2(2)
Line: 17 (0)

Figure 26 — SIP Trunk alarm

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Use a network sniffing tool (e.g., Wireshark) to monitor the SIP signaling between the
enterprise and TDS. The sniffer traces are captured at the LAN2 port interface of the Avaya
IP Office.
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8. Conclusion

TDS passed compliance testing excepting the limitation in Section 2.2. These Application Notes
describe the procedures required to configure the SIP connections between Avaya IP Office and the
TDS system as shown in Figure 1.

9. Additional References

[1] Administering Avaya IP Office Platform with Manager, Release 10.0, September 2016.

[2] Deploying Avaya IP Office™ Platform Solution, Release 10.0, 15-601042 Issue 31q, 06
February 2017

[3] Using Avaya Communicator for Web, Release 1.0, Issue 1.0.6, May 2016.

[4] Using Avaya Communicator for Windows on IP Office, Release 10.0, August 2016.

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XMI&TEMPLATE=pdf feed_ template.html

Product documentation for TDS SIP Trunk may be found at: https://tdsbusiness.com/products/voip-
phone/trunking.html
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property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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